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Beskrivelse af denne session 
Workshoppen er designet til de erfarne MicroStation brugere og CAD-administratorer. Deltagere i 
denne hands-on workshop lærer hvordan annotation scale kan implementeres som en del af 
deres projekt standarder, og hvordan de kan integrere den i arbejdsgange  ved tegnings 
produktion. Vigtige emner omfatter tegnings sammensætning, annotation scale og styring af 
standarder.  

LÆRINGSMÅL 

Efter denne workshop vil du være istand til at:  

 Definere hvad annotation scale er og hvordan det kan anvendes I MicroStation.  

 Anvende annotation scale i reference filer. 

 Ændre en Custom line style definition ved hjælp af annotation scale 

Note Ved slutningen af denne workshop vil I få nogle evalueringsspørgsmål. Vi vil gennemgå 
alle spørgsmål og svar for at se, hvad du har lært. 
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Kapitel1: Annotation Scale 

OVERBLIK 

Annotation Scale er en valgfri skalerings faktor, der er gældende for forskellige elementtyper 
såsom tekst og dimension elementer, brugerdefinerede line typer og til selve sheet elementet. 
Anvendelse af Annotation Scale vil sikre, at når et skaleret print er oprettet, så vil annotations 
vises i den den korrekte fysiske størrelse i forhold til print skalaen. 

Således er Annotation Scale hovedsageligt en "plot skala", der anvendes på elementtyper, der 
skal skaleres til at matche det ønskede output skala af tegningen 

Hvad Annotation Scale er: 

 En model egenskab i en tegningsfil der er unik per Model. (design, drawing eller 
sheet) 

 Indstillingen er dynamisk 

 Kan bruges til at skalere op og ned. 

 Du kan definer hvilke data der styres af annotation scale, ved at bruge Annotation 
Scale låsen  (bortset fra custom line styles der er globale) 

Hvad Annotation Scale ikke er: 

 Er ikke beregnet til at forblive statisk (dvs. Settings Manager) 

 Ændre working units til forskellige skalaer.  

 Virker ikke med patterns (skraveringer) 

 Kan ikke indstilles uafhængigt per linie type. (alt eller intet)  

 Applikationer ovenpå MicroStation kan måske ikke bruge Annotation Scale direkte.  

Husk, det den tilpasser elementer med relevans for "plot skala" 

 

Da Annotation Scale ikke virker med alt, så er her en liste med de elementtyper at Annotation 
Scale arbejder sammen med:  

 Text, text fields og notes 

 Dimensions 

 Cells 

 Detailing symbol styles 

 Custom line styles 

 Sheet model elementet 

 Reference fil elementer 

MODEL BASERET STYRING 

Annotation Scale er en model egenskab. Når du opretter en model, har du mulighed for at knytte 
en annotation scale til modellen. Hvis du i Model dialogboksen ændrer modellens annotation 
scale  vil  enhver tekst, dimensioner eller celler, som er placeret med annotation scale låsen 
aktiveret, vil disse automatisk blive skaleret med denne værdi. 

Når du ændrer en model’s annotation scale, og hvis Propagate Annotation Scale er aktiveret vil 
ekstistrende annotationer, der er placeret med annotation låsen aktivereret ændres. Hvis 
Propagate Annotation Scale ikke er aktiveret så skaleres de ikke. 
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Annotation scale låsen bestemmer om Annotation Scale målestoksforhold faktoren anvendes på 
elementer på tidspunktet for deres placering. Ikonet med låsen er tilgængelig forskellige steder: 
 

 Models dialog 

 Drawing Scale window 

 Tool Settings window 

 Locks pop-up menu 

 References dialog 

 Element Information dialog 

 Flere settings dialogbokse (eksempelvis Text Styles, Dimension Styles) 

ANNOTATION SCALE: 

 Indstilles i model properties 

 Default skala bestemmes af seed filen eller en seed model. 

 Til rådighed for alle typer modeler: 
o Design 
o Drawing 
o Sheet 

 Undo kan bruges 

Note Model Properties er også hvor Line Style Scale sættes 
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 Øvelse: Vælg workspace 

1. Start MicroStation. 

2. I nederste højre hjørne vælg følgende:  

 User: Bentleyuserdk2013 

 Project: AnnotationScale 

 Øvelse: Opret en model med Annotation Scale 

1. Indstil filtype til CAD Filer. 

2. Åbn filen 01 – Annotation Scale.dgn. 

3. Klik på Models ikonet for at åbne Models dialogboksen.  

 
 

4. Definer en ny model med navnet Annotation Model. 

 

 

 

 

 

 

 

 

5. Indstil Annotation Scale til Full Scale 1=1. 

6. Klik OK. 

7. Vælg Place Text. 

8. Sørg for at Annotation Scale låsen er aktiveret. 

9. Placer en tekst med annotation scale låsen aktiveret, hvor der står:  
“Med A trykket ind” 

 

10. Gentag proceduren, men nu med annotation scale låsen de-aktiveret. 
I teksten kan du skrive: 
”Uden A trykket ind” 
 

11. Indstil den active Annotation Scale til noget andet og bemærk resultatet.  

12. Se på de andre modeler i filen.  
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DRAWING SCALE DIALOG 

Drawing Scale dialogboksen kan dokkes og du kan bruge den til at kontrollere og ændre enheder, 
annotation scale, Annotation Scale låsen, vælge det active Auxiliary Coordinate System (ACS), ACS 
scale, og ACS scale låsen.  

Drawing Scale dialogen kan bruges til at ændre Annotation Scale indstillingen setting i en fart.  
Drawing Scale dialogen finder du under menupunket: Settings > Drawing Scale  

Drawing Scale dialog features: 

 Hurtig metode til at ændre Annotation Scale 

 Den kan dokkes 

 Den kan ændres I strørrelsen 

 Giver adgang til enheder og ACS 

 Kan ændres (højreklik) 

 

 

ANNOTATION SCALE LOCK  

Annotation Scale lock ikonet finds I tool settings vinduet for de værtkøjer som supporterer denne 
feature (pånær line styles). Tool Settings vinduet vises automatisk når man vælger en kommando.  

Annotation Scale lock ikonet findes I disse dialogbokse:  

 Model Properties 

 Place Text 

 Place Note 

 Dimensioning tools 

 Place Active Cell 

 Detailing Symbol Styles 

 Reference dialog 

 Lock værktøjskasse 

 Øvelse: Find Annotation Scale lock ikonet i de forskellige tool settings 

1. Vælg Drawing Task. 

2. Vælg Place Text. 

3. Find Annotation Scale lock ikonet. 

4. Gentag med de andre kommandoer der supporterer Annotation Scale. 
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BESTEM WORKFLOWET FOR DIN ANNOTATION SCALE  

Før du begynder at bruge Annotation Scale, skal du bestemme workflowet. Hvordan vil du 
anvende Annotation Scale? Vil du placere annotationer I din design model, I drawing modellen 
eller på sheet’et? Hvilken skala skal du anvende? Og er det 1:1 eller skaleret?  

Spørgsmål der skal stilles og besvares: 

 Printer du fra en sheet model? 

 Er dit papir 1:1 eller printer du I skala?  

 Anvender du styles? 

 Anvender du DGNLIB filer til at gemme dine styles? 

 I hvilken “skala” er dine custom line styles defineret i?  

 Er dine custom line styles I en ensartet målestok? 

 Har du brug for at skalere nogle line typer, men ikke andre? 

 Er der et behov for at anvende flere skalaer I samme model?  

Ved at besvare disse spørgsmål vil du begynde at forstå hvordan annotation scale vil influere på 
din tegnings opsætning og  hvordan du bedst tilpasser dit Annotation workflow til dine CAD 
standarder. Måske er der ting i din nuværende standard som kan ændres så det hele passer 
bedre sammen.  

 

AFSLUTNING PÅ KAPITEL 

I dette kapitel har vi diskuteret konceptet “annotation scale”  og anvendelsen af det. Vi har også 
set på de værktøjer som kan bruge Annostation Scale, og set på hvordan man aktiverer og de-
aktiverer låsen. Vi kom også omkring Drawing Scale dialogen, hvilket er den nemmeste værktøj til 
at justere på annotation scale når denne skal ændres. 
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Kapitel2: Tekst 

OVERBLIK 

Når man definerer standarder og vil bruge Annotation Scale, så er selve annotation scale workflowet 
særdeles vigtig.  I mange år har det været almindelig praksis at overdrive størrelsen af  tekster og 
dimensioneringer baseret på udskrivning på en skala faktor. Dette vil ofte føre til at have den samme 
"stil" (fastkodede gemte indstillinger), måske konfigureret via Settings Manager, skabt til flere skalaer af 
brug. Dette var ikke en fleksibel eller dynamisk tilgang til at placere tekst. Annotation Scale er beregnet 
til at hjælpe med dette. 

DEFINITION AF EN “ANNOTATION” TEXT STYLE 

Som netop omtalt, har det været almindelig praksis at overdrive størrelsen af tekster og dimensionerings 
indstillinger baseret på udskrivning på en skala faktor. Hvis teksten skulle være 5mm i højden på den 
udskrevne output, når print skalaen var at være 1:100, ville 5mm tekst skal ganges med 100 og dermed 
placeret 500mm i højden i modellen. Hvis man bruger annotation skala kan teksten konfigureres og 
placeres i en højde af 5mm med Annotation Scale (på 1:100) automatisk justerer tekststørrelsen. 

 

Dette vil give den samme tekst konfiguration, der skal bruges i enhver skala at opnå 5mm højde, der 
ønskes på udskriften. 

 Øvelse: Åbn DGNLIB filen 

1. Vælg File > Open… 

2. Files of Type ændres til DGN Library Files (*.dgnlib). 

3. Naviger ét mappe-niveau op. 

4. Åbn DGNLIB folderen. 

5. Åbn filen med navnet Annotation.dgnlib. 

6. Bemærk hvilke working units der er i dgnlib filen. 

7. Master Unit ændres til Meter (Settings > Design File > Working Units). 

8. Save Settings. 

 Øvelse: Definer en TextStyle som skal bruges med Annotation Scale 

1. Åbn Text Styles dialog boksen:  
Element > Text Styles 
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2. Definer følgende Text Styles: 

 

 

 

 

 

 

 

 

 

 

3. Luk DGNLIB filen.  

4. Naviger ét mappe-niveau op. 

5. Åbn DGN folderen. 

6. Åbn filen 02 - Intersection.dgn. 

7. I Drawing Scale dialogen aktiveres Annotation Scale lock og Annotation scale sættes 
til 1:100.  

8. Skriv nu tekster på gaderne og et par af de hvide bygninger. Anvend den rigtige 
TextStyle.  

9. Prøv at ændre Annotation Scale til 1:200 og se resultatet. 

  

NAVN FONT HEIGHT WIDTH JUSTIFICATION COLOR 

Buildings Arial .0050 .0045 Center Center 64 

Street Labels Arial .0075 .0075 Center Center 68 
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 Øvelse: Tilføj Annotation Scale til eksisterende tekst 

1. Bemærk hvordan Building 2 vises. 

2. Zoom ind til centered af bygningen.  
 
Bemærk, at der er eksisterende tekster i disse to 
bygninger. Denne tekst blev ikke gjort 
"annotatable", når den blev placeret. Vi vil nu tilføje 
Annotation Scale til denne eksisterende tekst. 

 
 
 
 

 

3. Aktiver følgende: 
 
Text Style (Indstil til Buildings) og Annotation 
Scale (aktiver Annotation Scale låsen). 

4. Vælg teksterne I hver bygning. 

5. Iagttag resultatet. 

 

 

 

 

TEXT FIELDS 

Når du placerer eller redigerer tekst, du kan indsætte fields, 
der repræsenterer indhold, der er afledt af et et elements attributter, model  egenskaberne  eller 
fil egenskaberne. Værdien for "indhold" i field’et  vil derefter vedligeholdes af MicroStation, 
baseret på en af disse værdier. 

Fields baseret på element attributter er altid opdateret og vil afspejle ændringer. Hvis et field 
indeholder arealet af et lukket element, vil teksten automatisk opdatere for at afspejle ændringen 
i elementet. 

Et field kan vises overalt inde i en anden tekst og kan spænde over flere ord eller linier. Fields 
baseret på model eller fil egenskaber er generelt opdateret når filen / modelen er åbnes, men 
denne handling styres via en model egenskaberne. 

Egenskaber af følgende typer af objekter kan bruges som kilder til fieldindhold: 

 Elementer 

 Models (eksemepelvis. Den aktive Annotation Scale) 

 Filer 

 Placeholder fields 



Indholdsfortegnelse 

 

Workshop:  W3 - Annotation Scale 

Bentleyuser.dk 2013 

  13 

Copyright © 2013 Bentley Systems, Inc. 

PLACEHOLDER FIELDS 

Ud over at indsætte fields i teksten, kan du også indsætte placeholderfields i en celle eller model. 
Et placeholder field er et field, der venter på en information. Når informationen er forudsat, kan 
det revurdere og vise dens værdi. I mangel af informationen, viser field istedet sit field navn. 
Informationen kan tilvejebringes ved hjælp af et link. 

For eksempel kan du oprette en celle, der indeholder en Place Holder Cell Properties field 
(indsættelsespunkt). I celle modellen viser field fieldnavnet ORIGIN. Når cellen placeres i en 
anden model, og fields opdateres, viser feltet orgin (indsættelsespunktet) af cellen. 

 

Place holder field i celle modellen (venstre). Place holder field efter den er placeret (højre). 

 Øvelse: Se hvordan Text Field opfører sig 

1. Åbn filen 03 – Text Fields.dgn. 

2. Se på indholdet af tegningen. Tekst elementerne er placeret i tabel og er linket til 
grund arealerne.  

3. Vælg Modify Element. 

 

4. Brug kommandoen til at ændre på størrelsen af en af grundene.  
Bemærk at tabellen ændres automatisk.  

5. Vælg menupunktet: File > Save As  

6. Gem filen som en anden DGN og navngiv den: Subdivision.dgn. 

7. Den nye DGN fil åbnes. 

8. Zoom in på tegningshoved området:  
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9. Bemærk at tegningsnavnet er stadig det same. 
 
Dette er et field der er linket til tegningens egenskaber.  
For at opdaterer dine fileds, skal du gøre én af følgende ting:  

I Key-in browseren taster du følgende kommando:  
  FIELD UPDATE ALL 

eller 

 I dialogboksen for model egenskaberne (Model properties) skal Update 
fields automatically aktiveres.  

 

 Øvelse: Tilføj et field til at vise den aktive Annotation Scale 

1. Vælg File > Open 

2. Naviger ét mappe-niveau op. 

3. Åbn Cell folderen. 

4. Åbn filen Borders.cel. 

5. Åbn modellen Title Block – D. 

6. Åbn Models dialog og verificer at følgende indstillinger er sat: 

o Annotation Scale: Full Size 1:1 
o Update Fields Automatically: Aktiveret 
o Cell Properties: 

 Can be placed as a cell: Aktiveret 
 Can be placed as an annotation cell: Aktiveret 

7. Luk Models dialog boksen. 

8. Zoom ind I nederste venstre hjørne af tegningshovedet. ( tekst elementet: SCALE ) 

9. Brug Text Editoren til at tilføje et Text Field til den eksisterende tekst, og dette field 
skal afspejle modellens aktuelle annotation scale. 

10. Luk for  filen. 

Note Vi vil kigge nærmere på denne cell/cell library senere i denne workshop.  

 

AFSLUTNING PÅ KAPITEL 

I dette kapitel lærte vi, hvordan du opretter en TextStyle med den hensigt at bruge det i et 
workflow sammen med annotation Scale og hvordan man anvender denne TextStyle til 
eksisterende tekst elementer. Vi kom også ind på brugen af en tekster med annotation scale, der 
ligger inde i en celle. 
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Kapitel3: Dimensions 

OVERBLIK 

Der er også support for brugen af annotation scale når man sætter mål på tegninger, det vi også 
kalder dimensions. I dette kapitel vil vi se på brugen af annotation scale relateret til dimension 
elementer.  

DIMENSIONS 

Brugen af Annotation Scale sammen med dimensions svarer meget til tekstplacering. Og 
Annotation Scale har evnen til at indstille størrelsen for følgende: 

 Teksten i dimensions 

 Terminators (pilene) 

 Extension lines (de opdateres) 

Og alligevel er her en lille advarsel. Når man placerer en dimension med annotation scale låsen, 
så vil tekst og terminatorerne straks blive påvirket. Når man senere ændrer annotation scale, så 
vil den skalere størrelsen på alle 3 komponenter (tekst, terminator og extension lines), hvilket vil 
resultere i at man ofter får brug for at tweake på extensionline afstanden da annotation scale 
fungerer som en multiplikator på deres længde. 

 Øvelse: Se en dimension med Annotation Scale 

1. Åbn filen med navnet: 04 – Dimensions.dgn. 

2. Åbn modellen Building Model. 

3. Åbn Dimension Styles dialogen og kig på dimensionstylen: Architectural. 
 
Bemærk særligt tekst størrelsen I denne dimensionStyle.  
 

4. Prøv at ændre den aktive Annotation Scale fra 1:50 til 1:100. 

5. Se ændringerne på de eksisterende elementer 

6. Slet disse dimensions. 
 
Iøvrigt…. Dimensioner er bedst egnede i den endelige sheet! 

 Øvelse: Placeren  dimension med Annotation Scale låsen aktiveret 

1. Åbn modellen Floor Plan 1. 

2. I sheet modellen placeres en ramme celle (Border cell, den finds som model I den 
active fil) 
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3. Tilknyt Building Model som reference til sheet’et. 

4. I model properties, aktivér Update Fields Automatically. 

 

Bemærk ændringerne I teksten I tegningshovedet.  

5. Placer en dimension på sheet’et.  

6. Denne dimension style var konfigureret til 1:1 print, og er derfor skaleret korrekt til 
at blive printet ud.  

 Øvelse:Brug en dimension style I et “skaleret” sheet 

1. Åbn modellen Floor Plan 2. 

2. Placer ramme-cellen i sheet modellen og brug annotation scale (1:50). 

3. Tilknyt Building Model som en reference og anvend Detail Scale : 1:50 
Brug evt. det saved view med navnet: Floor Plan 

 

4. I model properties, aktivér Update Fields Automatically. 

 

5. Placer en dimension på sheet’et. 

Sørg for at Annotation Scale låsen er aktiveret! 

6. Denne dimension style var oprindelig konfigureret til at blive printet 1:1. Men 
annotation scale tog vare på at skalere den i den skala som vi havde brug for.  

 

AFSLUTNING PÅ KAPITEL 

I dette kapitel lærte vi, at dimensionerne understøtter brugen af annotation scale samt 
annotation scale låsen. Og at det er muligt at placere dimensions hvor som helst, men at best 
practice tyder på at størstedelen af annotations, der er tegnings-specifikke skal placeres på 
sheet’et. Ved opsætning af dimensionStyles, bør man også anvende de styles som man bruger til 
teksterne (TextStyles)  
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Kapitel4: Celler 

OVERBLIK 

Annotation cells er celler der adlyder den aktive annotation scale. Det sker hvis du har aktiveret 
annotation scale låsen når de placeres.  

ANNOTATION CELLER 

Når du opretter en model til at indeholde celle geometri, kan du vælge at blive placeret som en 
annotation celle. Hvis annotation scale låsen er aktiveret vil cellen skalere ved placering, ligesom 
den vil skalere tekster og dimensioneringer. Hvis modellens annotation scale ændres, vil celler og 
enhver tekst i dem også skalere. 

Du bør ikke sætte en dimension inde i en annotation celle. Dette er fordi denne dimension vil vise 
en forkert værdi, når cellen er skaleret. Dette sker, hvis ændrer modellens annotation scale og 
viser modelen gennem en reference med en aktivt annotationscale. Når en annotation celle er 
skaleret, er den normale geometri skaleret, men dimensions fortsætter med at vise den 
oprindelige værdi. 

 Øvelse: At arbejde med Annotation Celler 

1. Åbn filen 05 – Annotation Cells.dgn. 

2. Bemærk at den aktive annotation scale (Full Scale 1=1) samt indholdet af 
tegningen. 

3. Den aktive annotation scale ændres til 1:10. 

4. Bemærk at træerne (celler), tekster og custom line styles ændres.  

5. Den aktive annotation scale ændres nu til 1:20 (hvilket I dette tilfælde er den 
ønskede print skala) 

6. Åbn cell library dialogen. 

7. Attach cell biblioteket Annotation Cells.cel. 

8. Se på dialogboksen. 
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9. Særligt bemærk den kollonne med det lille A (Annotation)  

10. Prøv at placer celler og brug Annotation Scale låsen. 

11. Juster på Annotation Scale og se resultatet af de nyligt placerede celler. 

 

ANNOTATION SCALE FOR EKSISTERENDE ANNOTATION CELLER 

For allerede placerede annotation celler, kan du enten aktivere eller de-aktivere annotation scale 
ved brug af key-ins.  

For at aktivere annotation scale låsen: 
ANNOTATIONSCALE ADD  

For at fjerne / de-aktivere annotation scale låsen: 
ANNOTATIONSCALE REMOVE.  
 
hvis et selection set er aktivt vil dette ske for de valgte celler. Hvis ingen celler er valgt vil 
ændringen ske for alle celler i modellen. 

ÆNDRING AF ET EKSISTERENDE CELLE BIBLIOTEK 

Det er muligt at tage eksisterende celle biblioteker og ændre deres model egenskaber så de bliver 
skalerbare vha. Annotation scale.  Dette kan gøres pr. celle definition eller for udvalgte celler. For 
at ændre en enkelt celle skal man gå ind I model egenskaberne for cellen. For at ændre en række 
celler skal dette gøres i Model dialog boksen.  

 

Højreklik på kollonneoverskriften og tilføj kategorien Annotation Cell. 
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 Øvelse: Tilføj Annotation scale på eksisterende celler 

1. Åbn celle biblioteket/filen  Annotation Cells.cel 

Hint Den hurtigste måde at gøre dette for et allerede tilknyttet celle 
bibliotek. Er at højreklikke på en celle i cell library dialogboksen og 
vælge Open for Editing. 

2. Åbn Models dialog boksen. 

3. Tilføj kollonen Is Annotation Cell. 

4. Rediger annotation sacale indstillingen for de modeller du skal ændre.  

5. Gen-åbn tegningen og se cellerne i cell library dialogboksen. 
 

  

ASLUTNING PÅ KAPITEL 

I dette kapitel har vi lært hvordan man placerer celler med annotation scale og set hvilken 
indvirkning den har på dem. Vi har også set på hvordan vi får cellerne defineret og redigeret til at 
kunne anvende annotation scale. 
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Kapitel5: Referencer 

OVERBLIK 

Referencer understøtter den aktive models annotation scale. Du har måske tilføjet annotationer 
direkte på dit sheet. Hvis disse annotationer var for små, så har du måske ændret den aktive 
models annotation scale, dette vil umiddelbart kun have effekt på de elementer der ligger direkte 
i din aktive model. Alle annotationer der ligger i referencen ændres ikke. Det du kan gøre, er at 
anvende den aktive annotation scale på dine referencer, og dermed skalare indholdet i 
referencerne. Tidligere skulle du ind i referencerne og skalere annotations manuelt, det behøver 
man ikke at gøre mere. 

REFERENCE FILER 

I MicroStation V8i SELECTseries editions, kan den aktive model’s annotation scale anvendes af 
referencerne. Hvis du ændre skalaen på annotationer på dit sheet, så vil også annotationer i 
referencerne ændre sig.  

For at får referencen til at ændre sig skal ”Use Active Annotation Scale” aktiveres for referencen. 
Denne kollonne er ikke umiddelbart synlig i reference dialogboksen, men med et højreklik kan du 
få kollonnen vist. Ud over det er ikonet også vist i bunden af reference dialogboksen. 
 

 

Note Eksisterende annoteringer i en DGN file fra tidligere MicroStation verisoner kan ikke 
skaleres automatisk. For at gøre dem skalerbare brug denne key-in: 
ANNOTATIONSCALE ELEMENT SETDYNAMICFLAG. 
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 Øvelse: At arbejde med referencer 

1. Åbn filen 06 – References – Sheet Model.dgn. 

2. Iagttag vej og bygnings teksterne. 
Disse burde have den samme tekststørrelse på det endelig print. Problemet er at 
hver reference har forskellige aktiv annotation scale, og disse er forskellig fra den 
aktive models annotation scale.  
 

3. Åbn References dialog boksen for at rette op på dette problem 

4. Gå ind I hver reference og se hvad den aktive annotation scale er I hver model.  

5. Returner til 06 – References – Sheet Model.dgn. 

6. Find Annotation Scale låsen i references dialogboksen. 

Hint Hvis du ikke har Use Active Annotation Scale kollonen, så kan du 
høreklikke I kollonneoverskriften og få den frem.  

7. Vælg de ønskede referencer (Design og Topo). 

8. Klik på Annotation Scale låsen og tjek resultatet i den aktive model. 

 Valgfri Øvelse: At arbejde med referencer 

1. Åbn filen 07 – References – Design Model.dgn. 

2. Tjek den aktive annotation scale for hver af de tilknyttede referencer. 

3. Gå tilbage til 07 – References – Design Model.dgn. 

4. I reference dialogboksen vælg alle referencerne 

5. Aktiver ikonet Use Active Annotation Scale. 

6. Se på resultatet. 

ASLUTNING PÅ KAPITEL 

I dette kapitel har vi lært hvordan man bruger annotation scale sammen med referencer. Dette 
kan gøres i sheet modellen, på drawing modellen eller i design modellen. Man kan også indstille 
den for alle eller udvalgte referencer.
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Kapitel6: Line Styles 

OVERBLIK 

Custom line styles understøter også brugen af en models Annotation Scale. Man kan vælge at 
custom line styles skal bruge en global skala eller annotation scale. Dette påvirker alle custom line 
styles I modellen, og ikke per element, hvilket vil sige at det er anderledes end ved placering af 
tekster, dimensions og celler. 

CUSTOM LINE STYLES 

Indstillingen sættes i Model Properties dialog boksen. Line Style Scale lader dig vælge hvilken type 
skala der skal anvendes, samt det er muligt at indstille den aktive annotation scale.  

 

Hvis model’en Style Scale sættes til Annotation Scale, så vil alle custom line styles skaleres med 
denne faktor. 

UNDERSØG LINE STYLES SCALE 

Hvis man ikke ønsker at line styles skal skaleres, så kan man I definitionen af denne bestemme om 
den er skalerbar eller ej. Denne ændring gælder både ved brugen af Global Line Style Scale og  
Annotation Scale. Metoden til at gøre dette er at ændre den custom linie style er til at være 
“physical”. Hvis en linetype er physical, så skaleres den ikke. 
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 Øvelse: Indstil en line type til at være Physical 

1. åbn filen 08 - Line Styles.dgn. 

2. Bemærk linie typen Rail Road Track. Prøv at ændre på  den aktive Annotation Scale. 

3. Fra main menuen vælg: Element > Line Styles > Edit. 

4. I Line Style editoren vælg: Select File > Open. 

5. Naviger til folderen: 

C:\Documents and Settings\All Users\Application Data\Bentley\MicroStation V8i 
(SELECTseries)\WorkSpace\Projects\ AnnotationScale \symb\ 

6. Åbn projektet’s line style resource fil: Linestyles.rsc. 
7. Marker Railroad på listen 

8. Fra menuen vælg: Edit > Physical. 

9. Vælg Save og close (Line Style.rsc filen). 

10. Exit og genstart MicroStation. 

11. Prøv at ændre Annotation Scale og se hvordan   
Railroad line stylen nu opfører sig.  

 

ASLUTNING PÅ KAPITEL 

I dette kapitel har vi lært hvordan vi indstiller en models egenskaber til at kontrollere skalering af 
custom line styles. Vi har også se på hvordan man kan definere en custom line style der ikke 
reagerer på hverken Global Line Style Scale eller Annotation scale.  
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Kapitel7: Sheet Models 

OVERBLIK 

En sheet model en den type model der fungerer som et elektronisk stykke papir. Typisk 
indeholder det referencer fra design eller drawing modells, og ofte er de også skaleret for at 
kunne være på papiret. Normalt har view’et en hvid baggrundsfarve, og man kan se papiret’s kant 
(boundary). Sheet modellen kan skaleres ved at bruge annotation scale, og man kan dermed 
nemt sætte et skalérbart printmiljø op.  

ET “DYNAMISK” SHEET 

En interaktiv eller ”dynamisk” sheet model kan defineres, og kan anvendes til  hvilken somhelst 
print skala. Denne type sheet model defineres med en annotation scale sat til 1:1 og 
tegningshovedet sættes på som en celle, og denne celle skal være en annotation cell.  

 Øvelse: Definition af en dynamisk sheet model 

1. Åbn filen 09 – Title Block.dgn. 

2. Tilknyt celle biblioteket Borders.cel   
(naviger én folder op, og gå ned i folderen cell) 

3. I cell library dialog boksen dobbeltklik på cellen Title Block – D 

4. Sørg for at annotation scale låsen er aktiveret. 

5. Indstil den aktive annotation scale til 1: 1:000 

6. Placer cellen ved at snappen til nederste venstre hjørne på sheet’et. 

7. Rediger den aktive annotation scale. 

8. Bemærk at sheet modellen’s boundary skalerede sig, men tegningshovedet gjorde 
ikke.  

9. Undo så tegningshovedet ikke er placeret. 

10. I cell library dialog boksen vælges cellen Title Block – D, højreklik på cellenavnet og 
vælg: Open for Editing. 

11. Sørg for at celle definitionen er en annotation cell.  

12. gå tilbage til filen 09 – Title Block.dgn. 

13. Placer cellen igen på sheet’et, ligesom før. 

14. Rediger den aktive annotation scale og bemærk resultatet.  
Du kan også prøve at bruge denne som en seed model ! 
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ASLUTNING PÅ KAPITEL 

I dette kapitel har vi lært at en sheet model’s boundary bruger den aktive annotation scale. Vi har 
også lært hvordan man kan ændre og placere et tegningshoved der skalerer sig når den aktive 
annotation scale ændres.  



 

 

Workshop:  W3 - Annotation Scale 

Bentleyuser.dk 2013  

  26 

Copyright © 2013 Bentley Systems, Inc. 

 
 
 
 
 
 

Kapitel7: Multi-Scale Detail Sheets 

OVERBLIK 

Denne metode kan du anvende hvis du har behov for flere forskellige skalaer på dine sheets.  

Typisk vil geometrien være tegnet i 1:1, og på papiret vil du måske vise ting fra designmodellen i 
forskellig skala. Bemærk at du naturligvis ikke skal tegne en detalje og derefter skalere 
geometrien ned for at få den til at passe til rammen. Ved brug af nedenstående metode kan 
detaljerne nemt ændres eller genbruges.  

SCALING THE DETAILS 

Èn metode til at lave et sheet med detaljer, er at have et sheet og derefter reference de 
forskellige detaljer ind på sheet’et. Med denne metode vil rammen/sheet’et være I 1:1 og hver 
reference kan derefter skaleres I den skala der er behov for. Alle tekster og dimensions vil blive 
placeret i fuld størrelse. 
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 Øvelse: Tilknyt detalje referencer i forskellig skala. 

1. Åbn filen 10 – Multi-Scale Details.dgn. 

2. Åbn Model Detail C. 

3. Vælg kommandoen: Dimension Linear. 

4. Verificer at den aktive annotation scale er sat til 1:25 og at annotation scale låsen 
er aktiveret. 

5. Vælg Detail Dimensions som den aktive DimensionStyle. 

 

6. Placer et mål på røret som illustreret: 
 

 

7. Definer et saved view, som vist nedenfor: 
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8. Gå tilbage til Sheet modellen. 
9. Fra Saved Views dialog boksen  drag and drop det saved view ind på sheet’et. 

(der er nogle punkter der kan hjælpe med placeringen) 
10. Efter Drag and drop bliver du spurgt om hvilken attachment metode du vil 

anvende. Vælg: Interactive. 
11. I reference attachment settings dialogboksen,bemærk hvilken detail scale den 

foreslår. 
12. Gentag procedure for alle 3 modeller/Saved views. 

 

ASLUTNING PÅ KAPITEL 

I dette kapitel lærte vi hvordan man kan definer et sheet med mange detaljer på, hvor hver har 
deres egen skala. Den aktive annotation scale var forskellig i hver enkelt model og denne 
indstilling blev anderkendt når referencerne blev tilknyttet. Teksten var tilmed i samme størrelse, 
selvom de var I hver deres skala I modellerne.  
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Learning Paths 
Alle vores kurser hos Bentley er tilgængelige via learning paths. Hvilket er  klargjorte 
uddannelsesplaner, med vores anbefalinger til  kurser til udvikling af færdigheder for et produkt, 
løsning, job rolle, eller erfaring niveau. 

Når dit team skal udvikles så kan vi vælge fra Bentley’s anbefalede learning paths, eller du kan 
vælge at konfigurer din egen for at møde dine eller dit teams behov.  

Learning paths hjælper os med at: 

 Udvikle vores talenter 

  Gøre os mere produktive 

 Prioritere emner der skal læres - hvad der er vigtigt for os som virksomhed 

 Styrker vores virksomhedskultur med løbende læring 

 

Se mere her: http://learn.bentley.com 

Du skal logge ind. Brug dit SELECT login, kan du ikke huske det prøv først ”Forgot Password” før at 
du opretter dig! 

 

Link til en learning path der netop handler om denne Annotation Scale: 

http://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=105554 

 

Link til en learning path om LEARN serveren: 

http://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=104483 

 

Link til en learning path med flere emner om MicroStation fra Bentley LEARNing konferencen 
2013. 

http://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=104811 

 

 

  

http://learn.bentley.com/
http://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=105554
http://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=104483
http://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=104811
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Evaluering 
1. Hvad er annotation scale? 

 

2. Alle custom line styles virker med annotation scale. 

 

3. Patterns (skraveringer) kan skaleres op og ned ved hjælp af annotation scale. 

 

4. Du kan skalere tekster i referencer ved hjælp af annotation scale 
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Evaluerings svar 
1. Hvad er annotation scale? 

Annotation scale er en model egenskal der er unik for enhver model (design, drawing, eller 
sheet) I en tegningsfil der bruges til at dynamisk kontrollere størrelsen af annotation objekter.  

2. Alle custom line styles virker med annotation scale. 

Forkert! Custom line styles kan også sættes op til at blive styret af enten en models global line 
style scale eller en line style kan defineres “physical” så linien ikke skaleres.  

3. Patterns (skraveringer) kan skaleres op og ned ved hjælp af annotation scale. 

Forkert!. Patterns understøtter ikke brugen af annotation scale. 

4. Du kan skalere tekster i referencer ved hjælp af annotation scale 

Korrekt!. Ved at bruge Use Active Annotation scale er det muligt at skalere tekster, dimensions, 
celler  

 


